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When	working	on	a	project,	many	novice	graphic	designers	and	photographers	place	their	elements	on	the	canvas	and	try	to	space	them	perfectly	by	eyeballing	them.	Why	try	to	eyeball	it	when	you	can	have	Photoshop	align	and	distribute	your	layers	accurately?		To	align	layers	in	Photoshop,	select	two	or	more	layers	from	the	Layers	Panel,	then
activate	the	Move	Tool	(V).	Now	press	Command	+	A	(Mac)	or	Control	+	A	(Win)	to	select	your	canvas,	then	use	any	of	the	align	options	found	in	the	options	bar	to	align	your	selected	layers.	It’s	a	small	thing	to	remember	that	will	save	you	hours	in	the	long	run.	By	the	end	of	this	article,	you’ll	know	everything	you	need	to	know	about	getting
Photoshop	to	place	your	elements	where	you	want	them	and	space	them	evenly	without	measuring.		The	alignment	options	in	Photoshop	are	all	about	placing	your	elements	around	your	canvas	or	selected	area,	whether	you	want	to	center	text,	shapes,	or	move	elements	to	the	edge	of	the	canvas.	There	are	two	ways	for	you	to	align	the	elements	in
your	project.	To	use	the	first	method,	go	to	Layer	>	Align	and	choose	the	type	of	alignment	you’re	looking	for.		The	second	and	easier	way	to	align	the	objects	in	your	project	is	by	selecting	the	Move	Tool	(V)	and	using	the	Options	bar	to	align	your	elements.		To	do	this,	select	all	the	elements	you	wish	to	align	in	the	Layers	panel.		Then,	select	the	Move
Tool	(V)	in	the	Toolbar,	to	show	the	settings	in	the	Options	bar	at	the	top	of	the	screen.		Auto-Select	–	To	make	things	easier,	tick	on	Auto-Select	and	then	choose	Layer	in	the	drop-down	menu.	This	will	allow	you	to	click	on	an	element	and	select	it	immediately.	Left	Edges	–	This	option	will	align	elements	to	the	left	edge	of	your	selection	border	or	the
leftmost	pixel	detected.	Horizontal	Centers	–	This	option	will	align	your	elements	to	the	center	of	the	horizontal	plane	or	your	selected	layers’	most	horizontal	center	pixel.	Right	Edges	–	This	option	will	align	elements	to	the	right	edge	of	your	selection	border	or	the	rightmost	pixel	detected.	Top	Edges	–	This	option	will	align	elements	to	the	top	edge
of	your	selection	border	or	the	topmost	pixel	detected.	Vertical	Centers	–	This	option	will	align	your	elements	to	the	center	of	your	selected	layers.	Bottom	Edges	–	This	option	will	align	elements	to	the	bottom	edge	of	your	selection	border	or	the	bottommost	pixel	detected.		It’s	worth	noting	that	a	single	layer	cannot	be	aligned	unless	there	is	a
selection.	That	means	to	align	a	layer	to	your	entire	canvas,	you	must	first	select	the	entire	document	by	pressing	Command	+	A	(Mac)	or	Control	+	A	(Win).	From	there	you	can	use	the	alignment	options	to	align	your	selected	layer	based	on	the	active	selection.	The	distribution	settings	in	Photoshop	are	all	about	spacing	your	elements	equally.	You
can	distribute	the	elements	in	your	project	by	going	to	Layer	>	Distribute,	then	picking	the	way	you	want	to	distribute	your	elements.		The	faster	way	to	distribute	your	elements	is	to	select	the	Move	Tool	(V)	and	use	the	distribute	options	in	the	Options	bar.		Distribute	Horizontally	–	This	option	will	produce	even	spacing	between	all	your	selected
elements	on	the	horizontal	plane.	Distribute	Vertically	–	This	option	will	produce	even	spacing	between	all	your	selected	elements	on	the	vertical	plane.		In	the	Options	bar,	you	will	also	find	the	Three	Dots	Icon.	Click	it	to	reveal	more	options.		Top	Edges	–	Spaces	your	elements	evenly,	starting	from	the	topmost	pixel	of	each	element.	Vertical	Centers
–	Spaces	your	elements	evenly,	starting	from	the	vertical	center	pixel	of	each	element.	Bottom	Edges	–	Spaces	your	elements	evenly,	starting	from	the	bottommost	pixel	of	each	element.	Left	Edges	–	Spaces	your	elements	evenly,	starting	from	the	leftmost	pixel	of	each	element.	Horizontal	Centers	–	Spaces	your	elements	evenly,	starting	from	the
horizontal	center	pixel	of	each	element.	Right	Edges	–	Spaces	your	elements	evenly,	starting	from	the	rightmost	pixel	of	each	element.		Before	aligning	your	layers,	ensure	that	you’re	aligning	your	layers	to	the	canvas.		To	do	this,	select	the	Move	Tool	(V)	and	click	on	the	Three	Dots	in	the	Options	bar.	Under	the	Align	To	drop-down	menu,	choose
Canvas.		To	align	the	elements	of	your	project,	you	first	need	to	select	the	layers	you	wish	to	align	each	time.		You	can	do	this	by	clicking	on	your	first	layer	in	the	Layers	panel,	holding	down	the	Shift	key,	and	clicking	the	last	layer	you	wish	to	add	to	your	selection.	This	will	automatically	select	all	the	layers	between	the	two	layers	you	clicked.		You
can	also	individually	select	your	layers	in	the	Layers	panel	by	holding	down	Control	(Win)	or	Command	(Mac)	and	clicking	on	the	layers	you	wish	to	select.		This	option	will	align	all	your	elements	to	the	left	edge	of	the	canvas.		(Note:	the	images	below	will	be	aligned	but	not	distributed.	So	the	spacing	between	the	elements	will	not	be	perfect.	I	will
explain	distribution	later.)		This	option	aligns	your	elements	to	the	middle	of	the	canvas,	specifically	to	the	vertical	plane	of	your	canvas.		This	option	will	align	all	your	elements	to	the	right	edge	of	the	canvas.		Using	this	option,	you	will	send	your	elements	to	the	top	of	the	canvas.		This	option	aligns	your	elements	to	the	middle	of	the	canvas,
specifically	to	the	horizontal	plane	of	your	canvas.		If	you	want	your	elements	to	be	aligned	to	the	perfect	middle	of	your	canvas,	use	this	option	in	combination	with	the	Align	Horizontal	Centers	option.		Using	this	option,	you	will	send	your	elements	to	the	bottom	of	the	canvas.		All	of	these	alignment	options	work	with	single	elements	as	well	as
groups.	Before	trying	to	align	groups	of	elements,	ensure	Group	is	selected	in	the	drop-down	menu	for	Auto-Select	in	the	Options	bar.		This	will	make	it	easier	for	you	to	select	your	group	by	clicking	on	it.		From	there,	you	can	align	your	groups	precisely	like	you	would	with	single	elements.		The	other	way	you	can	align	your	elements	is	by	using
Selection	Tools.	First,	make	sure	to	choose	Selection	in	the	Align	To	drop-down	menu.		To	start,	select	the	Rectangular	Marquee	Tool	(M),	or	any	other	selection	tool,	then	form	the	shape	you	need	on	your	canvas.		Select	one	of	your	elements	and	then	click	on	an	alignment	option.	Remember,	you	can	combine	more	than	one	alignment	option.		You	will
often	need	to	combine	alignment	options	to	avoid	having	a	random	element	float	within	your	selection.		Distributing	your	layers	is	all	about	making	sure	your	elements	are	evenly	spaced.	Distributing	your	layers	works	best	after	you’ve	already	aligned	them.	Here’s	what	happens	when	you	don’t	align	your	layers	first.		Here	are	some	elements	on	a
canvas:		Here’s	what	happens	when	clicking	the	Distribute	Vertically	option.		Barely	anything	happened.	Now,	let’s	try	aligning	the	elements	with	the	Align	Vertical	Centers.		A	much	more	significant	change,	but	the	spacing	is	not	perfect.	This	is	why	aligning	your	elements	first	is	better.	Now	is	the	best	time	to	click	Distribute	Horizontally.		Here’s
another	example.	First,	select	all	your	layers	in	the	Layers	panel,	then	click	Align	Horizontal	Centers.	To	evenly	space	your	elements,	click	on	Distribute	Vertically.		Photoshop	will	space	your	elements	perfectly	in	only	two	clicks.		There	are	so	many	different	options	and	combinations	for	distributing	your	layers	that	there’s	no	way	I	can	show	all	of
them	to	you	here.		You	can	use	Photoshop’s	Auto	Align	function	by	selecting	your	layers	and	then	going	to	Edit	>	Auto-Align	Layers.		You	will	have	six	options	under	Projection:		Auto	–	Photoshop’s	AI	analyzes	your	images	and	determines	if	they	should	apply	a	Perspective	or	Cylindrical	layout.	This	is	based	on	which	option	will	produce	a	better
composite.	Perspective	–	This	option	will	use	one	of	your	images	as	a	source	and	then	overlap	your	other	images	around	it	to	form	a	cohesive	piece.	Collage	–	Photoshop	will	align	layers	and	overlapping	content	while	retaining	the	shape	of	the	objects.	For	example,	if	one	of	your	layers	is	a	circle,	it	will	remain	a	circle.	Cylindrical	–	This	option	reduces
any	distortion	when	using	the	perspective	layout.	This	setting	is	best	suited	for	producing	wide	panoramas.	Spherical	–	Photoshop’s	AI	will	designate	your	source	image	as	a	reference,	then	spherically	transform	the	other	images.	This	setting	will	often	distort	your	images	into	a	circular	shape.	Reposition	Only	–	This	setting	aligns	the	layers	of	your
project	and	matches	overlapping	content	without	distorting	any	of	the	source	layers.		Most	of	these	settings	are	easy	to	figure	out	for	your	project	through	trial	and	error.		One	of	the	options	that	will	be	used	more	often	would	be	the	perspective	option.	This	option	will	allow	you	to	essentially	“stitch”	similar	images	into	one.		First,	make	sure	your
images	have	enough	overlapping	pixels.	Photoshop	suggests	at	least	40%.		Go	to	Edit	>	Auto-Align	Layers.	Choose	Perspective	and	click	on	OK	to	confirm.		Your	images	will	be	glued	together	into	one	picture.	This	image	should	look	seamless	and	much	easier	to	create	than	if	you	tried	to	line	up	your	photos	manually.	The	auto-align	feature	is	mostly
used	for	panoramic	images	but	can	be	also	used	with	sliced	images	too.	Do	you	need	tips	on	aligning	layers	in	Photoshop,	or	are	you	having	trouble	placing	your	image	layers	correctly	in	space?	Is	creating	panoramic	images	something	you	need	to	master?Below	are	two	Adobe	Photoshop	best	practices	on	how	to	align	layers	in	Photoshop.	These
methods	let	you	align	the	contents	of	layers	and	groups	using	the	Move	tool	or	the	Auto-Align	option.	You’ll	find	the	Photoshop	align	tool	in	the	Options	panel,	located	above	the	Image	panel	when	the	Move	command	is	selected.	These	tools	are	intuitive,	but	if	you	lack	basic	skills,	you	may	wonder	why	they	are	often	out	of	sight.	With	the	activated
Move	tool,	open	the	Align	and	Distribute	panel	under	the	“three-dots”	button.	Then,	pinpoint	the	Align	to:	setting.	If	this	is	set	to	Selection,	you	need	to	pick	out	an	active	selection	marquee	or	multiple	layers	in	the	Layers	panel	for	the	Align	buttons	to	be	accessible.	To	choose	multiple	layers	in	the	Layers	panel,	hold	down	the	Ctrl	key	on	PC	or	the
Command	key	on	Mac	and	each	layer	you	need.	This	procedure	is	akin	to	grouping	layers	in	Photoshop.	At	this	point,	the	process	looks	quite	transparent:	you	can	align	layers	in	Photoshop	to	any	edge	or	the	center	of	your	selection	using	the	corresponding	button.	But	you	can	also	use	another	method	from	the	next	step.	You	don’t	have	to	align	in
Photoshop	using	only	buttons	because	you	can	also	change	the	Align	To:	setting	to	Canvas	to	align	one	or	more	layers	to	the	entire	document,	which	is	a	great	help	in	centering	multiple	layers	neatly	without	having	to	do	any	calculations	yourself.	This	step	is	optional	because	the	Move	tool	may	not	give	the	desired	results.	In	this	case,	the	Smart
Guides	feature,	available	by	default,	can	help	you	deal	with	an	odd	alignment	situation,	such	as	proving	that	two	parts	of	the	image	keep	the	same	distance	from	the	document	edges.Taken	together,	the	Move	tool’s	alignment	features	and	Smart	Guides	are	a	great	convenience	that	makes	you	forget	what	it's	like	to	waste	time	calculating	offsets	and
pixel	measurements.	Many	standard	Photoshop	tasks	require	automatic	layer	alignment,	which	is	trickier	than	the	methods	described	above.	It	is	very	useful	for	focus	stacking,	compositing	HDR	images,	panoramas,	and	other	creative	projects	involving	multiple	images.	First,	open	multiple	images	as	layers	in	Photoshop.	Go	to	the	File	menu,	choose
Scripts,	and	select	Load	Files	into	Stack.	When	launching,	Photoshop	will	open	the	Load	Layers	dialog	box	and	provides	easy-to-reach	shortcuts.	Click	the	Browse	button	and	load	files.	You	can	also	click	Add	Open	Files,	which	will	let	you	load	the	whole	folder	full	of	photos	right	away.	Once	you	see	your	photos	as	separate	layers	in	the	same	document,
go	to	the	Edit	menu	and	choose	Auto-Align	Layers.	The	Auto-Align	Layers	dialog	box	appears,	offering	you	several	alignment	options	from	which	you	can	pick	out	the	ones	you	want.	Optimally,	you	should	rely	on	Auto	and	let	Photoshop	choose	a	specific	setting.	Especially	if	you	don't	know	which	one	you	need	since	many	of	them	are	designed	for
creating	panoramas.	Click	the	OK	button,	and	Photoshop	will	do	its	work	in	the	background	while	scanning	each	layer	for	any	alignments	and	setting	up	placement	and	shape	if	necessary.	You	can	stick	to	the	individual	tips	laid	down	in	these	Photoshop	tutorials	and	apply	other	tools	and	features	to	make	your	photos	look	different.When	it’s	done,	and
your	layers	are	finally	aligned,	consider	high-quality	retouching	for	the	entire	photo.	With	this	kit,	you	can	edit	a	whole	bunch	of	images	in	no	time	and	choose	a	fantastic	effect.	Try	these	actions	and	see	how	natural	your	photos	can	look	once	the	lighting	defects	are	eliminated.	Smart	guides	let	you	align	layers	in	Photoshop	very	quickly	without
delving	into	manual	instructions.	When	they're	enabled,	and	you	move	layers	around	the	canvas,	Photoshop	proactively	shows	you	adjacent	elements	making	it	easy	to	get	the	best	possible	alignment.Although	they	are	enabled	by	default,	Smart	Guides	are	only	visible	when	there	is	something	to	recommend.	To	check	if	they	are	still	active,	go	to	the
View	menu,	then	to	the	Show	submenu,	and	make	sure	there	is	a	checkmark	next	to	the	Smart	Guides.If	they	are	at	work	and	you	still	don't	see	them,	test	that	Extras	is	also	enabled	in	the	View	menu	at	the	top	of	the	Show	submenu.First,	select	three	or	more	layers.	Then	choose	Layer	>	Distribute	and	select	a	command.	Alternatively,	you	can	select
the	Move	tool	and	click	a	Distribute	button	in	the	Options	bar.	Select	the	desired	distribution	option.	Beyond	compositing,	align	auto	layers	can	spice	up	creative	projects.	Think	about	combining	multiple	shots	of	the	same,	perhaps	group	shots,	with	everyone	looking	their	best!	Use	Adobe	Bridge	to	simplify	organizing.	Once	loaded,	align	all	the	layers
efficiently	so	every	smile	and	pose	stands	out.Play	around	with	the	options	even	more.	For	example,	create	panoramas	by	stitching	photos	side	by	side.	Ensure	you	load	files	in	sequence	and	align	them	for	an	immersive,	continuous	image.	Don’t	stop	there:	try	artistic	effects	by	experimenting	with	the	checkerboard	pattern,	filling	gaps	created	by
slight	misalignments	and	adding	to	the	collage	effect.Remember,	the	move	tool	is	handy	when	repositioning.	If	a	selection	needs	slight	adjustments	post-alignment,	use	the	move	tool	to	fine-tune.	As	you	practice,	you’ll	feel	more	comfortable	with	the	process,	boosting	both	creativity	and	efficiency.Pro	Tip:	Save	time	and	avoid	hassle	by	frequently
saving	your	work	as	you	go;	it’s	easy	to	lose	track	during	intricate	edits.Additionally,	learning	Photoshop	shortcuts	can	significantly	speed	up	your	workflow	and	enhance	your	editing	efficiency.Learning	how	to	use	aperture	priority	mode	can	greatly	improve	your	photography	projects.	This	setting	offers	control	over	depth	of	field,	essential	for
capturing	sharp	images	and	enhancing	your	overall	camera	skills.	Written	by	Steve	Patterson.	How	many	times	have	you	found	yourself	trying	to	choose	between	two	similar	photos	of	your	subject	where	neither	photo	is	perfect?	It's	a	common	problem	with	group	shots	where	in	one	photo,	someone's	eyes	are	closed,	and	in	the	other,	someone	else	is
looking	in	the	wrong	direction.	Wouldn't	it	be	great	if,	rather	than	being	forced	to	choose	between	them,	there	was	an	easy	way	to	merge	the	two	images	together,	keeping	only	the	best	elements	from	each	photo,	to	create	that	elusive,	perfect	shot?	Fortunately,	there	is!	In	this	tutorial,	we'll	learn	how	to	easily	align	and	composite	images	in
Photoshop.	In	fact,	you	may	be	surprised	by	just	how	easy	it	is	to	do	since	we're	going	to	let	Photoshop	do	much	of	the	work	for	us.	First,	we'll	use	a	command	few	people	know	about	to	automatically	load	our	photos	into	the	same	document	and	place	each	one	on	its	own	independent	layer.	Then,	we'll	align	the	images	using	Photoshop's	powerful	Auto-
Align	Layers	command.	Finally,	we'll	use	a	layer	mask	to	hide	the	unwanted	areas	in	one	photo	and	replace	them	with	the	better	versions	from	the	other	photo!	I'll	be	using	Photoshop	CC	here	but	this	tutorial	is	also	fully	compatible	with	Photoshop	CS6.	Here's	the	two	photos	I'll	be	working	with,	taken	one	sunny	afternoon	while	driving	around	the
countryside.	In	this	first	image,	I	like	the	horse	on	the	right	as	it	approaches	and	looks	straight	into	the	camera,	but	the	horse	on	the	left	is	looking	down	and	showing	me	nothing	but	the	top	of	its	head:	The	first	image.	This	second	photo,	taken	a	few	seconds	earlier,	gives	me	a	better	view	of	the	horse	on	the	left,	but	the	horse	on	the	right	is	further
back	in	the	frame	and	not	as	interesting	as	it	was	in	the	first	shot:	The	second	image.	What	I'd	like	to	do	is	combine	the	best	elements	from	both	versions,	taking	the	horse	on	the	right	from	the	first	photo	and	merging	it	with	the	horse	on	the	left	in	the	second	photo.	Here's	what	the	final	composite	version	will	look	like:	The	final	composite.	You	can
use	the	same	steps	we're	about	to	learn	to	align	and	merge	all	kinds	of	images,	from	family	and	group	shots	to	animals	and	pets,	landscape	and	nature	photos,	or	whatever	the	case	may	be,	so	feel	free	to	follow	along	with	your	own	images.	Let's	get	started!	Before	we	can	align	and	merge	our	photos,	we	first	need	a	way	to	get	them	both	into	the	same
document,	with	each	image	on	its	own	separate	layer.	There's	actually	an	easy	way	to	do	this,	but	few	people	know	about	it.	Simply	go	up	to	the	File	menu	in	the	Menu	Bar	along	the	top	of	the	screen,	choose	Scripts,	and	then	choose	Load	Files	into	Stack:	Going	to	File	>	Scripts	>	Load	Files	into	Stack.	If	"Load	Files	into	Stack"	sounds	confusing
(which	it	does),	think	of	it	instead	as	"Load	Files	into	Layers"	because	that's	exactly	what	the	script	does;	it	opens	two	or	more	images	into	the	same	document	and	places	each	image	on	its	own	layer.	In	fact,	there's	a	command	in	Adobe	Bridge	named	"Load	Files	into	Photoshop	Layers"	that	does	the	same	thing,	but	for	this	tutorial,	we'll	stick	with
Photoshop.	Once	you've	selected	the	script,	Photoshop	will	pop	open	the	Load	Layers	dialog	box.	This	is	where	we	tell	Photoshop	which	images	to	open.	Click	the	Browse	button:	Clicking	the	Browse	button	in	the	Load	Layers	dialog	box.	Navigate	to	the	folder	on	your	hard	drive	where	the	images	you	want	to	merge	are	located.	In	my	case,	both	of	my
photos	are	in	a	folder	on	my	Desktop.	I'll	click	on	the	first	image	to	select	it,	then	I'll	press	and	hold	my	Shift	key	and	click	on	the	second	image.	This	selects	both	images	at	once.	With	both	of	your	photos	selected,	click	the	Open	button:	Shift-clicking	on	the	images	to	select	them	both,	then	clicking	Open.	You'll	see	your	selected	images	listed	in	the
center	of	the	Load	Layers	dialog	box.	Click	OK	to	load	them	into	Photoshop:	Clicking	OK	to	load	the	selected	images.	It	may	take	a	few	moments,	but	both	images	will	be	loaded	into	the	same	document,	each	on	its	own	layer.	Since	the	photos	are	sitting	one	above	the	other,	we	can	only	see	one	of	them	at	a	time	in	the	main	document	area:	Both
images	were	loaded,	but	only	one	is	currently	visible.	If	we	look	in	the	Layers	panel,	though,	we	see	that,	sure	enough,	both	photos	are	there.	The	one	on	the	top	layer	is	the	one	currently	visible	in	the	document,	but	if	you	click	on	its	visibility	icon	to	the	left	of	the	layer,	you'll	temporarily	turn	it	off,	revealing	the	other	image	below	it:	Clicking	the	top
image's	visibility	icon	to	turn	it	off.	With	the	top	layer	turned	off,	the	image	on	the	bottom	layer	is	now	visible	in	the	document.	Click	the	same	visibility	icon	again	to	turn	the	top	image	back	on:	Turning	off	the	top	layer	reveals	the	photo	on	the	bottom	layer.	Learn	all	about	layers	in	Photoshop!	Step	2:	Select	Both	Layers	In	a	moment,	we're	going	to
align	the	images,	but	to	do	that,	we	first	need	to	have	both	layers	selected.	Click	on	the	top	layer	in	the	Layers	panel	to	select	it	if	it	isn't	selected	already.	Then,	press	and	hold	your	Shift	key	and	click	on	the	bottom	layer.	This	will	select	both	layers	at	once:	Clicking	the	top	layer,	then	Shift-clicking	the	bottom	layer	to	select	them	both.	With	both
layers	selected,	go	up	to	the	Edit	menu	at	the	top	of	the	screen	and	choose	Auto-Align	Layers:	Going	to	Edit	>	Auto-Align	Layers.	This	opens	the	Auto-Align	Layers	dialog	box.	Photoshop	is	quite	capable	of	doing	an	amazing	job	when	aligning	images,	so	we'll	let	it	do	all	the	work.	Leave	the	Projection	option	at	the	top	set	to	Auto	(the	default	setting),
then	click	OK:	The	default	"Auto"	option	is	all	you	need.	Again,	it	may	take	a	few	moments,	but	when	it's	done,	your	photos	should	be	aligned	with	each	other.	You	can	click	on	each	layer's	visibility	icon	in	the	Layers	panel	to	toggle	it	on	and	off	and	see	what	changes	Photoshop	has	made	to	get	them	aligned.	I'll	click	on	my	bottom	layer's	visibility	icon
to	turn	that	layer	off	temporarily:	Hiding	the	bottom	layer.	This	lets	me	view	just	the	top	image,	and	here	we	can	see	that	to	get	both	photos	aligned,	Photoshop	resized	and	rotated	the	top	image.	The	checkerboard	pattern	around	the	image	is	Photoshop's	way	of	representing	transparency:	The	top	image	was	resized	and	rotated	to	align	it	with	the
bottom	image.	I'll	click	the	same	visibility	icon	once	again	to	turn	the	bottom	layer	back	on:	Clicking	the	empty	square	to	toggle	the	visibility	back	on.	And	now,	we	see	just	how	great	of	a	job	Photoshop	has	done.	There	is	a	noticeable	horizontal	line	cutting	across	the	image	near	the	top	where	the	shade	of	blue	in	the	sky	doesn't	match	between	photos,
but	I'll	fix	that	in	a	moment.	Overall,	Photoshop	did	an	amazing	job:	The	images	after	running	the	Auto-Align	Layers	command.	Now	that	our	images	are	aligned,	we	can	use	a	layer	mask	to	hide	the	unwanted	areas	in	the	top	image	and	reveal	the	better	versions	from	the	image	underneath.	Click	on	the	top	layer	in	the	Layers	panel	to	select	it,	which
deselects	the	bottom	layer	at	the	same	time:	Selecting	just	the	top	layer.	Click	on	the	Add	Layer	Mask	icon	at	the	bottom	of	the	Layers	panel:	Clicking	the	Add	Layer	Mask	icon.	Nothing	will	happen	to	the	image	in	the	main	document	area,	but	a	white-filled	layer	mask	thumbnail	appears	on	the	top	layer	in	the	Layers	panel.	If	you	want	to	learn	more
about	how	layer	masks	work,	be	sure	to	check	out	our	full	Understanding	Layer	Masks	in	Photoshop	tutorial:	The	Layers	panel	showing	the	new	layer	mask	thumbnail.	To	hide	the	unwanted	areas,	we'll	need	to	paint	on	the	layer	mask	with	a	brush.	For	that,	we'll	need	Photoshop's	Brush	Tool.	Select	the	Brush	Tool	from	the	Tools	panel	along	the	left	of
the	screen:	Grabbing	the	Brush	Tool.	With	the	Brush	Tool	selected,	click	on	the	Brush	Presets	icon	in	the	Options	Bar	along	the	top	of	the	screen:	Clicking	the	Brush	Preset	icon.	This	opens	Photoshop's	Brush	Preset	Picker.	Double-click	on	the	first	thumbnail	(the	one	in	the	top	left)	to	select	the	soft	round	brush.	Double-clicking	both	selects	the	brush
and	then	closes	out	of	the	Brush	Preset	Picker:	Double-clicking	the	soft	round	brush	thumbnail.	In	order	to	hide	areas	on	the	top	layer,	with	need	to	paint	on	the	layer	mask	with	black.	Photoshop	uses	the	Foreground	color	as	the	color	of	the	brush,	so	to	quickly	set	your	Foreground	color	to	black,	first	press	the	letter	D	on	your	keyboard	to	make	sure
your	Foreground	and	Background	colors	are	set	to	their	defaults	for	working	with	layer	masks.	This	sets	your	Foreground	color	to	white	and	your	Background	color	to	black.	Then,	to	swap	them	so	your	Foreground	color	is	black,	press	the	letter	X	on	your	keyboard.	You	can	see	your	current	Foreground	and	Background	colors	in	the	color	swatches
near	the	bottom	of	the	Tools	panel.	Your	Foreground	color	swatch	is	the	one	in	the	upper	left.	It	should	now	be	filled	with	black:	The	Foreground	color	should	be	black.	With	a	soft	round	brush	in	hand	and	black	as	the	Foreground	color,	simply	paint	over	any	areas	in	the	top	image	that	you	want	to	hide	and	replace	with	the	same	area	from	the	image
below	it.	In	my	case,	I	want	to	replace	the	horse	on	the	right	with	the	better	version	of	the	horse	from	the	other	image,	so	I'll	begin	painting	over	the	horse.	Since	I'm	painting	on	the	layer	mask,	not	on	the	image	itself,	we	won't	see	the	black	color	of	my	brush	strokes.	Instead,	the	top	horse	begins	to	disappear	in	the	areas	I'm	painting	over,	replaced
by	the	better	version	of	the	horse	below	it.	It	looks	a	bit	like	a	science	experiment	gone	wrong	at	the	moment,	but	it	will	look	better	when	I'm	done:	Painting	with	black	on	the	mask	to	swap	the	horses.	Here's	a	few	handy	tips	to	help	you	out	as	you're	painting	on	the	mask.	To	change	the	size	of	your	brush	from	the	keyboard,	press	the	left	bracket	key	(
[	)	repeatedly	to	make	it	smaller	or	the	right	bracket	key	(	]	)	to	make	it	larger.	To	change	the	hardness	of	the	brush,	press	and	hold	the	Shift	key	while	pressing	the	left	bracket	key	to	make	the	edges	softer	or	the	right	bracket	key	to	make	them	harder.	If	you	make	a	mistake	and	paint	over	an	area	you	didn't	mean	to,	press	the	letter	X	on	your
keyboard	to	swap	your	Foreground	and	Background	colors,	making	your	Foreground	color	white.	Paint	with	white	over	the	mistake	to	bring	back	the	image	on	the	top	layer.	Then,	press	X	again	to	switch	your	Foreground	color	back	to	black	and	continue	painting	away	other	areas.	I'll	continue	painting	over	the	area	until	I've	completely	replaced	the
horse	in	the	top	image	with	the	same	horse	from	the	bottom	image:	The	original	horse	has	now	been	replaced	with	the	better	version	below	it.	I	also	want	to	make	sure	I	swap	out	the	shadow	being	cast	by	the	horse,	so	I'll	paint	over	that	area	as	well:	Painting	over	the	shadow	on	the	ground.	If	you	want	to	compare	the	original	and	composite	versions,
you	can	temporarily	turn	off	the	layer	mask	by	pressing	and	holding	your	Shift	key	and	clicking	on	the	layer	mask	thumbnail	in	the	Layers	panel.	A	red	"X"	will	appear	letting	you	know	the	mask	has	been	disabled:	Shift-clicking	on	the	mask	thumbnail	to	temporarily	disable	it.	With	the	mask	disabled,	we	see	the	original,	unedited	version:	The	original
version	of	the	photo.	Press	and	hold	Shift	and	click	again	on	the	layer	mask	thumbnail	to	turn	the	mask	back	on	and	view	the	composite	version:	The	composite	work-in-progress.	To	fix	that	harsh,	horizontal	line	near	the	top	of	the	image	where	the	shade	of	blue	doesn't	match	between	images,	I'll	press	the	right	bracket	key	(	]	)	on	my	keyboard	a	few
times	to	make	my	brush	size	larger,	and	with	my	brush	edge	still	nice	and	soft,	I'll	simply	paint	across	that	line	to	create	a	smooth	transition	between	the	photos:	Painting	with	a	large,	soft	brush	across	the	sky.	If	you	want	to	view	the	actual	layer	mask	itself	in	the	document	so	you	can	see	exactly	where	you've	painted,	press	and	hold	the	Alt	(Win)	/
Option	(Mac)	key	on	your	keyboard	and	click	on	the	layer	mask	thumbnail	in	the	Layers	panel:	Alt-clicking	(Win)	/	Option-clicking	(Mac)	on	the	mask	thumbnail.	This	temporarily	replaces	your	image	in	the	document	with	the	layer	mask.	White	represents	the	areas	where	the	top	image	remains	visible.	Areas	you've	painted	over	to	reveal	the	image	on
the	bottom	layer	appear	in	black.	Here,	we	can	see	where	I've	painted	over	the	horse	and	the	sky,	and	I've	also	painted	along	the	right	edge	to	smooth	out	a	few	more	harsh	transition	edges:	Viewing	the	layer	mask	itself	in	the	document.	To	hide	the	layer	mask	and	switch	back	to	your	image,	once	again	press	and	hold	your	Alt	(Win)	/	Option	(Mac)	key
and	click	on	the	layer	mask	thumbnail.	And	with	that,	we're	done!	Here	is	my	final	composite	of	the	two	original	photos:	The	final	result.	Graphic	DesigningGraphic	Design	SoftwareAdobe	Photoshop	Tutorials	In	this	Photoshop	Lesson,	we’ll	learn	about	‘Auto-Align	Layers	command	in	Photoshop‘.	Auto-Align	Layers	command	is	available	under	Edit
menu	in	Photoshop.My	name	is	Lalit	Adhikari	and	we	are	at	LTY.	Let’s	begin!Auto-Align	LayersThe	Auto-Align	Layers	command	under	Edit	menu	in	Photoshop	can	automatically	align	layers	based	on	similar	content	in	different	layers,	such	as	corners	and	edges.We	assign	one	layer	as	a	reference	layer	or	let	Photoshop	automatically	choose	the
reference	layer.	Other	layers	are	aligned	to	the	reference	layer	so	that	matching	content	overlays	itself.Hence,	it	is	used	frequently	for	creating	panoramic	images.Image	–	1Image	–	2Image	–	3Related	Topics:How	to	use	Auto-Align	LayersTo	show	the	use	of	Auto-Align	Layers	command,	I’ll	be	creating	a	panoramic	image	using	the	three	images
mentioned	above.First,	I’ll	open	‘Image	-1’	in	photoshop.	After	that,	I’ll	place	other	images,	‘Image	–	2’	and	‘Image	–	3’	in	the	same	document	as	different	layers.Images	opened	and	placed	in	Photoshop	DocumentImage	place	after	opening	‘Image	–	1’	will	be	placed	as	Smart	Object,	we’ll	need	to	Rasterize	those	layers.To	create	panoramic	image	from
the	above	opened	images,	we	have	to	select	all	the	layers	in	the	layer	panel.All	layers	selectedRelated	Topics:Go	to	Edit	>	Auto-Align	Layers…Auto-Align	Layers	dialog	boxDifferent	options	available	in	Auto-Align	Layers	dialog	box	are	as	follow:Auto:	In	this	method,	Photoshop	analyzes	the	source	images	and	applies	either	a	Perspective	or	Cylindrical
layout,	depending	on	which	produces	a	better	composite.Perspective:	It	creates	a	consistent	composition	by	designating	one	of	the	source	images	(by	default,	the	middle	image)	as	the	reference	image.	The	other	images	are	then	transformed	(repositioned,	stretched	or	skewed,	as	necessary)	so	that	overlapping	content	across	layers	is
matched.Cylindrical:	It	reduces	the	“bow-tie”	distortion	that	can	occur	with	the	Perspective	layout	by	displaying	individual	images	as	on	an	unfolded	cylinder.	Overlapping	content	across	layers	is	still	matched.	The	reference	image	is	placed	at	the	center.	Best	suited	for	creating	wide	panoramas.Spherical:	It	aligns	the	images	with	wide	fields	of	view
(vertical	and	horizontal).	Designates	one	of	the	sources	images	(the	middle	image,	by	default)	as	the	reference	image	and	spherically	transforms	the	other	images	so	that	overlapping	content	is	matched.Scene	Collage:	It	aligns	layers	and	matches	overlapping	content,	without	changing	the	shape	of	the	objects	in	the	image	(for	example,	a	circle	will
still	be	a	circle).Reposition	Only:	It	aligns	the	layers	and	matches	overlapping	content	but	does	not	transform	(stretch	or	skew)	any	of	the	source	layers.Two	options	for	Lens	Corrections	are	also	available:Vignette	Removal:	Compensates	for	a	lens	defect	that	causes	the	edges,	especially	the	corners,	of	an	image	to	be	darker	than	the	center.Geometric
Distortion:	Compensates	for	barrel,	pincushion,	or	fisheye	distortion.Related	Topics:In	this	case,	Auto	value	under	Projection	will	give	the	best	result.	Though	if	your	images	have	any	of	the	visible	defects	then	other	Projection	values	could	be	tested.Click	OKResult	after	Auto-Align	Layers	in	PhotoshopHere,	Photoshop	has	arranged	common	content
and	placed	images	to	create	a	possible	panoramic	image.	We	can	use	the	Auto-Blend	Layers	command	in	Edit	menu.	It	will	blend	the	layers	together	and	also	fill	transparent	areas	with	Content-Aware	Fill.With	all	the	layers	still	selected,	go	to	Edit	>	Auto-Blend	LayersAuto-Blend	Layers	under	Edit	menuThe	following	dialog	box	will	open:Auto-Blend
Layer	dialog	boxHere,	I’ve	chosen	Blend	Method	as	Panorama	and	also	checked	bottom	2	checkboxes.	They	will	blend	tones	and	colors	as	well	as	fill	transparent	areas	with	Content-Aware	Fill.Related	Topics:Screenshot	after	Auto-Blend	Layers	in	PhotoshopFinal	panoramic	outputRelated	Topics:	Today,	we'll	be	looking	at	how	to	use	the	auto	align
tools	in	Photoshop,	as	well	as	guides	and	snapping!	Photoshops	auto	align	tools	are	simple	but	powerful,	and	they'll	keep	you	from	sending	out	a	design	with	the	always	annoying	uncentred	text	or	misaligned	words.		If	you're	looking	to	speed	up	your	workflow,	try	one	of	the	hundreds	of	professional	plugins,	actions,	and	addons	that	Envato	Elements
has	to	offer!	And	if	you'd	like	to	learn	more	useful	tips,	here's	a	video	from	the	Envato	Tuts+	YouTube	channel	with	10	Essential	Design	Tips	for	Photoshop:	What	You'll	Learn	in	This	Photoshop	Auto	Align	Tutorial	How	to	auto	align	in	Photoshop	How	to	use	guides	in	Photoshop	What	is	snapping	in	Photoshop		How	to	turn	snapping	off	in	Photoshop	
How	to	align	layers	in	Photoshop	What	You'll	Need	To	complete	this	project,	you	will	need	the	following	resources:	Event	Flyer	Model	in	Flyer	Find	more	resources	on	Envato	Elements!	1.	How	to	Auto	Align	in	Photoshop	Step	1	Using	the	Move	tool,	select	the	layers	you	want	to	align.	You	can	hold	Shift	and	click	to	select	multiple	layers	all	at	once.	
Step	2	With	the	Move	tool	active,	look	towards	the	upper	Options	bar.	You	will	see	two	types	of	alignment	options.	One	group	Aligns,	while	the	other	Distributes.		Step	3	First,	let's	align.	We	have	a	total	of	six	choices:		Left	Edges:	Aligns	the	left	pixel	on	the	selected	layers	to	the	left	pixel	on	the	leftmost	layer.	Horizontal	Center:	Aligns	the	horizontal
center	pixel	on	the	selected	layers	to	the	horizontal	center	pixel	of	all	the	selected	layers.	Right	Edges:	Aligns	the	right	pixel	on	the	linked	layers	to	the	rightmost	pixel	on	all	selected	layers.	Top	Edges:	Aligns	the	top	pixel	of	the	selected	layers	to	the	topmost	pixel	of	all	selected	layers.	Vertical	Center:	Aligns	the	vertical	center	pixel	on	each	layer	to
the	selected	layers'	vertical	center.	Bottom	Edges:	Aligns	the	bottom	pixel	of	the	selected	layers	to	the	bottommost	pixel.	In	this	case,	I	want	all	of	the	text	to	be	center	aligned,	so	let's	choose	the	second	option,	Align	Horizontal	Center.	Step	4	That	is	how	to	auto	align	layers	in	Photoshop,	but	we	still	want	to	distribute	the	text	evenly.	To	Distribute
layers,	select	three	or	more	layers.	If	less	than	three	layers	are	selected,	the	Distribution	tools	will	be	grayed	out.		With	the	Move	tool	active,	look	at	the	upper	Options	bar.		Here,	we	have	two	Distribute	Spacing	options:	Horizontally:	Distributes	horizontal	spacing	between	the	layers	evenly.	Vertically:	Distributes	vertical	spacing	between	the	layers
evenly.	We	want	to	choose	to	Distribute	Vertically,	so	that	there	is	equal	spacing	between	each	line	of	text.		Step	5	You	can	select	the	Ellipses	icon	to	see	all	six	Distribute	options,	as	well	as	a	list	of	all	other	Align	options:	Top	Edges:	Spaces	the	layers	evenly,	starting	from	the	top	of	each	layer.	Vertical	Center:	Spaces	the	layers	starting	from	the
vertical	center	pixel	of	each	layer.	Bottom	Edges:	Spaces	the	layers	starting	from	the	bottom	pixel	of	each	layer.	Left	Edges:	Spaces	the	layers	starting	from	the	left	pixel	of	each	layer.	Horizontal	Center:	Spaces	the	layers	starting	from	the	horizontal	center	of	each	layer.	Right	Edges:	Spaces	the	layers	starting	from	the	right	pixel	on	each	layer.	2.
How	to	Use	Guides	in	Photoshop	Step	1	Guides	are	a	great	way	to	help	you	position	all	your	design	elements	precisely.		First,	make	sure	Guides	are	turned	on	by	going	to	View	>	Show	>	Guides	or	View	>	Extras.	Step	2	We	need	to	turn	on	our	Rulers	using	View	>	Rulers	to	place	a	Guide.	Step	3	Now,	drag	from	the	horizontal	Ruler	to	create	a
Horizontal	Guide	and	drag	from	the	vertical	Ruler	to	create	a	Vertical	Guide.	You	can	hold	Alt	to	switch	to	the	opposite	of	whatever	guide	is	currently	selected.	I	darkened	the	design	so	you	can	better	see	the	guides.			Step	4	To	move	your	Guides,	simply	click	and	drag.	Hold	down	Shift	and	drag	from	the	Ruler	to	create	a	Guide	that	snaps	to	the	ruler's
ticks.	Use	guides	to	align	design	elements	and	keep	consistent	spacing.		Step	5	To	remove	a	guide,	drag	the	guide	outside	the	Canvas.	Or,	to	delete	all	Guides,	choose	View	>	Clear	Canvas	Guides.	3.	What	Is	Snapping	in	Photoshop?	Step	1		While	moving	around	layers,	you	may	have	noticed	them	pulling	or	aligning	themselves	with	existing	layers	and
guides;	this	is	called	Snapping.	To	see	if	Snapping	is	on,	go	to	View	>	Snap.	A	checkmark	shows	that	snapping	is	active.		Step	2		Snapping	is	automatic,	but	you	can	specify	what	your	will	and	won't	snap.	Go	to	View	>	Snap	To,	and	choose	one	or	more	options.		What	you	choose	will	depend	on	the	work	you	do.	If	you're	working	on	a	flyer	with	lots	of
typography,	you	might	want	everything	to	stay	on.	However,	if	you	are	editing	a	photo,	you	may	only	want	layers	to	snap	to	Guides.		You're	Done!	And	that	is	how	to	auto	align	layers	in	Photoshop!	Making	sure	everything	is	properly	aligned	in	a	design	is	key.		And	more	often	than	not,	our	own	eyes	won't	catch	when	something	is	off-aligned	by	a	few
pixels,	but	luckily	the	Photoshop	auto	align	tools	will!	Want	Premium	Plugins,	Actions,	and	Resources?		Now,	if	you're	looking	to	supercharge	your	workflow	and	make	the	Photoshop	auto	align	tools	even	better,	try	out	one	of	the	hundreds	of	plugins,	actions,	and	add-ons	over	on	Envato	Elements!	ReOrder:	Layer	Panel	Sorting	Kit	(ZXP)	We	just
covered	how	to	auto	align	in	Photoshop,	but	why	not	keep	your	layers	just	as	organized?	ReOrder	is	full	of	one-button	solutions	for	sorting,	organizing,	and	cleaning	up	your	layer	stack.			The	Ultimate	1001	Text	Effects	(PSD)	Typography	and	layer	aliment	goes	hand	in	hand.	So	this	pack	of	over	1,000	text	effects	is	the	perfect	companion	to	your	new
alignment	tools!	Easy	Cut:	Layer	Splitting	Kit	(ZXP)	Guides	are	great	for	keeping	your	edges	clean	and	consistent,	so	why	not	supercharge	them	using	the	Easy	Cut	add-on	for	Photoshop?	Easy	Cut	lets	you	turn	guides	and	paths	into	instant	cutting	tools.	It's	great	for	making	clean	lines	and	shapes!	Image	Extend:	Clipping	&	Expansion	Kit	(ZXP)
Creating	a	design	and	forgot	to	add	extra	space	for	bleed	or	cutting	errors?	Not	a	problem	if	you	have	this	image	extending	add-on	for	Photoshop!	Just	add	your	amount	and	instantly	extend	the	edges	of	your	images.		Geometrical	Collage	Generator	Photoshop	Plugin	(ABR,	ATN,	PAT,	ZXP)	Now	that	you	know	how	to	align	layers	in	Photoshop,	create
instant	posters	using	the	Geometrical	Collage	Generator	plugin!	Great	for	posters,	flyers,	or	promotional	material,	this	plugin	does	almost	all	the	work	for	you.	Just	add	text,	and	you're	done!		Automatic	layer	alignments	are	one	of	the	most	useful	but	underappreciated	features	of	Photoshop.	Perhaps	it	says	something	about	my	personality,	but	a
slightly	misaligned	layer	can	make	my	brain	crackle	–	and	not	in	the	fun	PhotoshopBuzz	kind	of	way,	in	an	“I	have	to	fix	that	right	now”	kind	of	way.		Even	if	you’re	lucky	and	don’t	suffer	the	same	sort	of	mental	quirk,	it’s	still	possible	to	drive	yourself	to	frustration	trying	to	align	your	layers	by	hand.	Fortunately,	it’s	the	kind	of	task	that	computers
excel	at,	so	we	should	let	them	do	all	the	work!	Here’s	how.	1.	Align	Simple	Layers	Using	the	Move	Tool	Photoshop’s	layer	alignment	tools	are	actually	located	in	the	options	panel	at	the	top	of	the	image	window	when	the	Move	command	is	selected.	They’re	quite	simple	to	use,	but	if	you’re	not	familiar	with	the	basics,	then	you	might	wonder	why
they’re	often	unavailable.		With	the	Move	tool	active,	open	the	Align	and	Distribute	panel,	which	is	also	oddly	hard	to	find	(see	screenshot	below).	Next,	you’ll	need	to	locate	the	Align	To:	setting	(again,	see	below).	If	it	is	set	to	Selection,	you	need	to	have	an	active	selection	marquee	OR	multiple	layers	selected	in	the	Layers	panel	in	order	for	the
alignment	buttons	to	be	available.		To	select	multiple	layers	in	the	Layers	panel,	hold	down	the	Ctrl	key	on	PC	or	Command	key	on	Mac	and	click	each	layer	you	want	to	select.		At	that	point,	it’s	fairly	self-explanatory:	you	can	align	along	any	edge	or	the	center	of	your	selections	using	the	appropriate	button.	You	can	also	switch	the	Align	To:	setting	to
Canvas,	which	will	allow	you	to	align	one	or	more	layers	to	the	document	as	a	whole,	which	is	a	huge	help	for	accurately	centering	multiple	layers	without	doing	any	calculations	yourself.		I	don’t	know	why	Adobe	decided	to	make	these	useful	options	so	difficult	to	access,	but	I	suspect	it’s	because	they’re	trying	to	discourage	people	from	using
Photoshop	as	a	layout	program	in	favor	of	their	other	dedicated	graphic	design	programs.		For	a	while,	Photoshop	was	becoming	a	“one-stop	shop”	for	design	work,	and	that	doesn’t	really	fit	with	Adobe’s	plans	–	and,	to	be	fair,	it	also	doesn’t	fit	with	Photoshop’s	core	strengths.	2.	Align	Layers	With	Smart	Guides	Aligning	layers	can	be	a	complicated
business,	and	sometimes,	using	the	Move	tool	doesn’t	give	you	exactly	the	results	you’re	looking	for.		One	of	my	favorite	additions	to	Photoshop	is	the	Smart	Guides	feature,	which	intelligently	(or,	at	least,	sort	of	intelligently)	looks	at	your	image	and	guesses	your	intentions.	The	Smart	Guides	overlay	helps	you	while	aligning	two	separate	text	layers
by	hand	It	doesn’t	always	work	perfectly,	but	Smart	Guides	can	be	a	huge	help	for	tricky	alignment	situations,	such	as	ensuring	that	two	image	elements	are	the	same	distance	away	from	your	document	edges.	The	alignment	options	in	the	Move	tool	definitely	can’t	keep	up	with	that!	Smart	Guides	are	enabled	by	default,	but	they	only	appear	when
they’ve	got	something	to	offer.	To	ensure	they’re	still	enabled,	open	the	View	menu,	select	the	Show	submenu,	and	make	sure	there	is	a	checkmark	beside	Smart	Guides.	If	they’re	enabled	but	you’re	still	not	seeing	them,	make	sure	that	Extras	are	also	enabled	in	the	View	menu,	just	above	the	Show	submenu.		3.	Automatically	Aligning	Photos	There	is
another	type	of	automatic	layer	alignment	that’s	necessary	for	a	lot	of	common	Photoshop	tasks,	but	it’s	more	complicated	than	the	methods	above.	It’s	a	great	help	for	focus	stacking,	HDR	compositing,	panoramas,	and	other	creative	multi-frame	projects.	The	only	real	trick	to	this	process	is	how	you	open	your	images.	Since	all	your	images	need	to	be
on	separate	layers	in	the	same	document,	you	could	copy	and	paste	them	individually,	but	there’s	a	much	easier	way	–	especially	if	you’re	working	on	a	focus	stack	of	25	images!	Open	the	File	menu,	select	Scripts,	and	choose	Load	Files	into	Stack.		Photoshop	will	start	by	opening	the	Load	Layers	dialog	box,	offering	handy	shortcuts	like	Add	Open
Files	and	letting	you	open	an	entire	folder’s	worth	of	images	at	once.	Note:	You	can	also	check	the	Attempt	to	Automatically	Align	Layers	box	in	the	Load	Layers	dialog	box	to	make	this	a	one-step	process,	but	I’m	going	to	show	you	the	full	process	as	well	just	in	case	you	need	a	specific	alignment	type.	Now	that	you’ve	got	your	photos	open	in	the
same	document	as	separate	layers,	open	the	Edit	menu	and	click	Auto-Align	Layers.	Photoshop	will	open	the	Auto-Align	Layers	dialog,	which	lets	you	select	from	a	range	of	different	alignment	options.	Unless	you	know	specifically	which	setting	you	need,	it’s	usually	best	to	just	leave	it	on	Auto	and	let	Photoshop	sort	it	out,	as	most	of	the	options	are
used	for	creating	panoramas.	We	are	trying	to	do	this	all	automatically,	after	all!	Click	OK,	and	Photoshop	will	chug	away	in	the	background	for	a	moment	while	it	checks	each	layer	for	possible	alignments	and	adjusts	the	placement	and	shape	as	needed.		It	may	not	look	like	much,	but	small	misalignments	can	have	a	huge	impact	on	your	final	image
when	you’re	doing	multi-frame	compositing!	A	Final	Word	Photoshop	may	not	be	intended	as	a	graphic	design	layout	program,	but	there	are	still	plenty	of	good	reasons	to	automatically	align	your	layers.	A	combination	of	the	Move	tool’s	alignment	features	and	Smart	Guides	will	help	make	your	life	a	lot	easier,	and	you	won’t	have	to	spend	your	time
calculating	offsets	and	pixel	measurements.	Even	if	you	need	to	align	photo	layers	from	multiple	angles,	Photoshop	saves	the	day.	With	a	bit	of	luck,	you’ll	never	have	to	do	any	math	in	Photoshop	again	 		Happy	aligning!	About	Thomas	Boldt	This	guide	will	give	you	the	easiest	ways	to	align	layers	in	Photoshop.	I’ve	been	using	Adobe	Photoshop	for
many	years	and	I	have	to	say,	aligning	layers	is	something	I	end	up	needing	to	do	regularly.	Aligning	layers	helps	you	to	get	the	components	of	a	design	or	images	straight.	And,	it’s	not	difficult	to	do	once	you	know	how!	Let’s	dive	into	the	tutorial	so	you	can	learn	how	to	do	it.	HIGHLY	RECOMMENDED	Adobe	Photoshop	Download	a	free	copy	of
Adobe	Photoshop	to	follow	along	with	this	simple	tutorial.	START	MY	FREE	TRIAL	How	to	Align	Layers	in	Photoshop	in	2	Easy	Steps	Aligning	components	of	an	image	is	important	when	you	want	a	design	to	have	a	professional	look.	It’s	not	always	possible	for	us	to	see	when	a	layer	is	out	of	alignment	by	a	few	millimeters.	Luckily,	Photoshop	has	some
handy	tricks	to	easily	get	layers	into	exact	alignment.	How	to	Auto-Align	Layers	This	method	will	automatically	snap	selected	layers	into	position.	This	method	gives	you	an	instant,	precise	result	in	six	different	positions.	Let’s	see	how.	Step	1	–	Select	all	Layers	The	first	step	is	to	select	all	the	layers	you	wish	to	align.	To	do	this,	hold	down	the	Shift	key
and	click	on	the	icon	of	each	layer	in	the	Layers	panel.	When	the	layer	turns	from	dark	grey	to	light	grey,	it	represents	that	it	has	been	selected.	If	you	want	to	select	all	layers,	head	to	the	top	menu	bar	and	choose	Layers	>	All	Layers.	All	the	layers	will	now	be	selected	and	ready	to	align.	Step	2	–	Align	Layers	head	to	the	top	menu	bar	and	select
Layers	>	Align.	(Note	that	if	it’s	impossible	to	select	Align,	it	will	be	because	no	more	than	one	layer	is	active	in	the	Layers	panel.	You’ll	need	to	go	back	to	step	1	and	select	more	layers.)	When	you	click	Align,	a	pop-out	menu	will	appear.	From	here,	you	will	be	given	six	choices.	You	can	align	the	layers	to	the	Top	Edges,	Vertical	Centers,	Bottom
Edges,	Left	Edges,	Horizontal	Centers,	or	Right	Edges.	Below	is	the	image	before	the	layers	were	aligned	to	the	top	edges.	The	following	image	is	how	the	layers	look	after	Top	Edges	has	been	clicked	as	an	alignment	choice.	As	you	can	see,	the	layers	will	be	precisely	aligned	to	the	topmost	layer,	in	this	case,	the	square.	The	image	below	shows	the
shape	layers	before	they	are	moved.	In	this	case,	only	the	square	and	the	ellipse	are	selected.	The	alignment	Vertical	Center	is	chosen,	and	only	the	square	and	circle	are	snapped	to	align	in	the	center	of	the	canvas.	The	image	below	shows	the	shapes	before	the	alignment	selection.	The	triangle	and	ellipse	shapes	are	selected,	and	from	the	main	menu
bar,	Align	>	Horizontal	Centers	is	clicked.	As	you	can	see	in	the	image	below,	the	shapes	are	snapped	into	a	central	position,	which	is	between	their	former	positions.	They	are	not	aligned	to	the	centre	of	the	canvas.	This	is	a	handy	two-click	editing	trick	to	know	when	you	need	to	snap	layers	into	alignment	when	creating	designs.	Now,	you	won’t	have
to	whip	out	Photoshop’s	rulers	and	grids	and	count	millimeters	to	align	layers.	How	to	Align	Layers	Using	the	Move	tool	You	can	also	use	the	Move	tool’s	options	tab	to	align	layers.	Click	on	the	Move	tool	in	the	toolbar,	and	its	options	bar	will	appear	over	the	canvas	workspace.	When	aligning	layers,	make	sure	that	layer	is	chosen,	not	groups.	Tick	the
box	beside	Show	Transformation	Controls,	and	a	bounding	box	will	appear	in	the	canvas	workspace	around	the	selected	layers.	The	bounding	box	can	be	a	helpful	indicator	of	which	boxes	are	selected.	As	you	can	see	in	the	image	below,	the	triangle	and	the	ellipse’s	layers	are	active,	and	the	bounding	box	is	placed	around	them,	excluding	the	square.
This	indicates	that	only	the	triangle	and	the	ellipse	will	be	moved.	When	the	square	is	activated	in	the	layers	panel,	the	bounding	box	will	automatically	include	it.	When	an	alignment	choice	is	selected,	the	shapes	will	be	repositioned	inside	the	bounding	box.	Click	one	of	the	alignment	icons	to	align	the	shape	layers.	The	first	icon	will	align	the	shapes
to	the	left	side	of	the	bounding	box.	The	second	will	align	them	to	the	middle	of	the	bounding	box,	and	so	on.	If	you	wish	to	align	the	layers	within	the	canvas	and	not	within	the	bounding	box:	Click	the	three-dot	icon	in	the	Move	tool’s	options	panel.	This	will	open	a	dialogue	window.	Click	on	the	arrow	beside	Selection	at	the	bottom	of	the	dialogue
window.	A	dropdown	menu	will	appear.	Change	the	choice	from	Selection	to	Canvas.	The	layers	will	now	be	aligned	to	the	boundaries	of	the	canvas.	Below,	we	can	see	that	the	images	are	ready	to	be	aligned,	and	all	the	shapes’	layers	have	been	selected.	The	image	below	shows	how	the	shapes	are	aligned	when	the	second	icon,	the	central	align	icon,
is	clicked.	The	next	image	shows	how	the	shapes	are	realigned	using	the	same	icon,	but	when	Canvas	has	been	selected.	The	shapes	are	now	aligned	centrally	to	the	canvas.	In	the	image	below,	all	the	shapes	are	selected	and	Canvas	has	been	activated.	The	seventh	icon	has	been	clicked,	the	Bottom	Edges	icon,	and	all	the	shapes	have	been	aligned	to
the	bottom	of	the	canvas.	The	Move	tool’s	options	tab	has	the	option	to	distribute	the	layers	within	the	alignment.	Click	on	the	three-dot	icon	and	open	the	dialogue	window.	You	will	find	the	Distribute	icons	in	the	second	box.	Click	on	any	of	the	Distribute	icons	to	align	the	layers	in	the	canvas	workspace.	Using	the	above	methods,	you	can	align	any
kind	of	layer,	including	text	and	image	layers.	Related:	How	to	Blend	Layers	in	Photoshop	Aligning	Layers	Free	Hand	The	following	method	will	guide	you	when	aligning	layers	in	Photoshop	freestyle.	Step	1	–	Select	Smart	Guides	First,	we	will	turn	on	the	Smart	Guides.	Head	to	the	main	menu	bar	and	select	View	>	Show.	In	the	pop-out	menu	that
appears,	check	to	see	if	there	is	a	tick	beside	Smart	Guides.	If	there	is	no	tick,	click	on	Smart	Guides	to	activate	it.	Step	2	–	Select	the	Move	Tool	From	the	toolbar,	select	the	Move	tool.	When	the	Move	tool	and	the	Smart	Guides	are	active,	guiding	lines	and	distances	will	appear	as	you	move	a	layer.	When	a	layer	is	in	alignment	centrally	with	another
layer	or	within	the	center	of	a	canvas,	a	line	will	appear	to	demonstrate	this.	As	shown	in	the	image	below,	the	purple	vertical	line	appears	to	show	that	the	shapes	are	centrally	aligned.	This	will	help	you	to	easily	align	your	layers	into	the	position	you	want.	Activate	Alignment	Guide	Lines	When	the	layers	are	stationary,	you	can	activate	guiding	lines.
Hold	down	Command	(for	Macs)	or	Ctrl	(for	Windows).	Hover	your	cursor	over	one	of	the	layers	which	is	not	active	in	the	Layers	panel.	The	triangle	layer	is	selected	in	the	image	below,	and	the	cursor	is	hovered	over	the	ellipse.	Photoshop	indicates	how	far	the	layers	are	from	each	other.	The	Move	tool	and	Smart	Guides	will	help	you	achieve	the
perfect	alignment.	Happy	editing,	and	have	fun	aligning	layers	in	Photoshop!	If	you	liked	this	tutorial,	you	might	enjoy	–	How	to	Focus	Stack	in	Photoshop.	How	do	I	evenly	align	in	Photoshop?	To	evenly	align	in	Photoshop,	activate	the	grids.	Then,	you	can	use	the	move	tool	to	align	the	objects.	Alternatively,	select	the	layers	you	wish	to	align	and	click
one	of	the	align	icons	in	the	Move	tool’s	options	bar.	How	do	I	arrange	layers	in	Photoshop?	To	arrange	layers	in	Photoshop,	click	on	the	layer	you	wish	to	move	and	drag	the	layer	up	or	down	the	Layer	panel	into	position.	Why	won’t	Photoshop	allow	me	to	auto-align	layers?	One	possible	reason	why	Photoshop	won’t	allow	you	to	auto-align	layers	is
that	the	layers	have	been	converted	into	smart	objects.	Smart	objects	are	non-destructive,	and	therefore,	not	all	editing	actions	can	be	performed	on	them.	How	do	you	adjust	multiple	layers	in	Photoshop?	To	adjust	multiple	layers	in	Photoshop,	you	can	group	them	in	a	group.	To	do	this,	click	the	folder	icon	at	the	bottom	of	the	Layers	panel.	When	the
folder	appears,	drag	the	layers	you	wish	to	adjust	together	into	the	folder.


